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Website:  https://legacyfamilytree.com/ 

 

Resources attached: 

o Legacy and DNA – Authored by Cathy Pinner and Michelle Simmons Lewis 

o Toolbars Breakdown – Cathy Amen 

 

Legacy Help Center: 

• Knowledge Base   https://legacyfamilytree.com/help-center/ 

• Troubleshooting   https://legacyfamilytree.com/help-center/?a=General-

Troubleshooting-Tips 

• Facebook User Group  https://www.facebook.com/groups/LegacyUserGroup/ 

• Intro to Legacy Videos  https://familytreewebinars.com/webinar-

library/?category=legacyfamilytree&subcategory=legacy1 

• Legacy Unlocked Videos  https://familytreewebinars.com/webinar-

library/?category=legacyfamilytree&subcategory=legacy9unlocked  

 

Legacy News Blog   https://legacynews.typepad.com/ 

 

Legacy Family Tree Webinars 

• Registration for webinars is free; recorded webinars are free for a week after the live session 

• Annual membership includes access to Webinar Library  $49.95/year (discount coupons 

available during live webinar) 

• Library as of 09/16/24: 2,267 webinars, 418 speakers, 8,859 syllabus pages 

 

 

Cathy Amen 

cathytamen@gmail.com 
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Source Clipboard 

 The Source Clipboard is a feature in Legacy that can tremendously increase the efficiency with 
which you document the sources of the information you enter into your Family File.  The Source 
Clipboard holds a copy of the source citation you are currently working from.  You can then record the 
source of each piece of information by simply clicking one button.  Optionally, each source clipboard 
can hold up to five different citations which can all be pasted at once.  This feature used to be in a 
previous version of Legacy and is now back by popular demand. 
  

Legacy can store up to 5 different Source Clipboards allowing you quick access to each one. You 
can quickly switch between sources when assigning sources to the details for one or more 
individuals. Use saved Clipboards when you have two or more individual sources you often use 
and want a quick way of choosing which is used for each fact or event.  (See Saving a Source 
Clipboard, Loading a Saved Source Clipboard, and Quick-Loading a Saved Source 
Clipboard at the end of this help topic for more information.  

  
You can set or change the master source citations by clicking the Step 1 link in the header area, 
Click here to select or change the master source to cite.  (See Master Source List for more 
information.)   The clipboard also holds the detailed information about where in the source the 
current information came from.  This is usually a page number, microfilm item number, etc.  The 
actual source text being cited can be entered on the Text/Comments tab.  You can also set the 
Surety Level for the source information.  This reflects your confidence in the accuracy of the 
information.  See Source Detail for more information.  In addition, you can enter a user file number 
to cross-reference the photocopies, extracts, and documents you find as you research your 
family.  To exclude a source citation on a report, uncheck the Include this Citation on Reports 
box.  To include the actual source text in citations printed on reports, check the Add this Text to 
the Source Citation on Reports box on the Text/Comments tab. If you want to be prompted for 
the Source Detail each time you use the clipboard, check the Prompt for Detail box at the bottom 
of the window.  This is a convenient way to cite sources that are on many different pages of a 
document. 
  
Adding Multiple Sources to the Clipboard 

The ability to place up to five source citations on the clipboard is optional in Legacy.  The option is 
set in the 7. Sources section of the Customize Legacy screen which is reached by choosing 
Customize from the Options tab on the Ribbon bar.  Scroll down to the 7.5 Source Clipboard - 
Capacity box and select the allowance of only one or up to five sources at a time on the 
clipboard.  (When you paste a source clipboard with multiple sources on it, all the sources (up to 
five) are added.  It doesn't matter which tab is current - all the source on the tabs with the asterisk 
(*) are pasted.) 

  
When you have entered the current source information, click OK to return to the entry form. 

  
Using the Source Clipboard 

mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/1n2nk1j.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/source_detail.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/hs570.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/hs560.htm
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Perhaps some examples will help to illustrate the value of this feature: 
  

You have just been to the local library and found a book that contains a lot of information about 
your ancestors. Page 211 of the book contains the following text: 

  
James Michael Martin Sr. was born on the 23rd of December, 1762, in Hackensack, New 
Jersey. On the 16th of May, 1784, Jim married Sarah Rebecca Gilbert somewhere in rural 
Bergen County, New Jersey, and they had the following children: 

  
1.  James Michael Martin Jr. Born 30 Apr 1785 in Hackensack. He married Ida Fredricks, 

daughter of Henry R. Fredricks and Millie Andrews, on 25 Dec 1806. Jim Jr. died in 1838 
in New York, NY. 

2.  Sarah Martin Born 22 Jun 1786 in Hackensack, NJ. Died young and was buried in 
Hackensack. 

3.  Rebecca Martin Born 8 Sep 1788. Married William Demarest in about 1807. They had 
six children. Becky died 15 Oct 1867 and was buried in Ohio. 

  
As you enter the information for each person on this page of the book, you should record the 
source of the information. Let's go through the steps: 

  
On the Individual's Information window, enter the information for James Michael Martin Sr.  
When you have finished, but before you click Save, set up the Source Clipboard with the 

source information. Click the Source Clipboard button.  
First make an entry in the Master Source List about the book we are using. To do this, click 

Click here to select or change the mastersource to cite to bring up the Master 
Source List window. 

Click Add to display the Add a New Master Source window. 
Choose the source template to use and then click Go to Step 2 

Enter the source information into the template fields.   
Save the master source and Select it for use in the Source Clipboard. 
In the Detail Information section, fill in the details fields.  (If there is more than one source 

on the clipboard, fill in the detail fields for all the sources.) 
Set the surety level to reflect your confidence in the accuracy of this information. 
Click Save to close the Source Clipboard and return to the Information screen. 

  
Now you are ready to assign the source citation to the information you have entered for James 
Michael Martin Sr. You have three choices from the Individual's Information window: 
  

You can place the cursor in the Given field and click the button to assign the source to 

just that piece of information. Place the cursor in the Birth field and click again. 
Continue doing this in each field on the window to assign the source from the clipboard. 
  

Or, you can click to have Legacy automatically assign the source to every field on the 
Information form that is not blank.  (This also includes all events in the event list.) 
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Or, you can click and have the source assigned to the general Unspecified category for 
this person. 

  
Option 1 is used when you return to add a newly found piece of information to an individual 
at a later time and want to assign a different source citation to that entry specifically. 

  
Option 2 is generally the best and fastest method to use when entering information for an 
individual for the first time.  

  
Option 3 is used if you are not interested in keeping specific source information for each 
type of event for an individual, but just want to record the source in one place. 

  
Saving the Source Clipboard 

If you find that you are reusing a particular source citation or set of citations, you can save it (or 
them) to disk for use in the future.  Up to ten different citation sets can be saved.  To save a 
citation set, click the Save Citations to Disk... button after loading the desired master source and 
filling in the detail fields.  When the Save Source Clipboard window appears, select one of the ten 
save positions by clicking on it.  Next, enter a name (up to 40 characters) in the Name field to 
describe the setup and then click Save. 

  
Loading a Saved Source Clipboard 

If you have saved one or more Source Clipboards, you can quickly load them back in by clicking 
the Load Citations from Disk... button.  When the Load Source Clipboard window appears, 
highlight the entry you want to load and then click Load.  (Or just double-click on the entry.)  The 
citation is loaded from disk and is placed on the clipboard. 

  
Quick-Loading a Saved Source Clipboard 

There is another quicker way to load clipboards that have been saved.  On any screen with a 

Source Clipboard button, , right-clicking the button displays a shortcut menu containing the 
names of all saved clipboards.  You can then simply click the citation you want and it is instantly 
loaded and ready to use. 

  
Note:  You can also Quick Copy a source citation from any individual, loading it into the Source 
Clipboard.  See Quick Copy Existing Citations to the Source Clipboard on the Citing the 
Sources of Your Information topic for instructions. 

  
Shortcut Keys for the Source Clipboard 

There are shortcut keys available when assigning source citations from the Source Clipboard. 
  

Alt-1   Opens the source clipboard.  (Same as clicking ) 

Alt-2   Assigns to the current field.  (Same as clicking ) 

Alt-3   Assigns to all non-blank fields.  (Same as clicking ) 

Alt-4   Assigns to the Unspecified area.  (Same as clicking ) 
  
Changing the Order of the Sources 

mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/sources_of_your_information.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/sources_of_your_information.htm
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When you are using the option to include up to five source citations on the Source Clipboard, the 
citations are added to a piece of information in the tab order.  That is, the citation on the Source 1 
tab is added first, the citation on the Source 2 tab is added next, and so on.  If you would like to 

move a tab to a different position, click the tab to make it current, and then use the and 
arrows at the bottom to move the tab left or right. 

  
Reprinted from Legacy 10 Help System 10-1182 : 230414  
 

 

 

 

 

Recommended Actions to do Periodically 
 

• Set Relationships (Tools>Relationship) 

• Run Potential Problems List (Reports>Potential Problems) 

• Run Media Relinker Report (Tools>Media Relinker) 

• Do File/Maintenance Actions (File>File Maintenance) 

o Check/Repair Family File (Do Backup File First!) 

o Compact Family File (Do Backup File First!) 

o List Cleanup 

o Rebuild Source Citations 

• Run Tree Finder to check for missing trees or individuals (View>Trees) 

• Run a Merge Report (Tools>Merge Duplicates) 
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Legacy Family Tree   

Shortcut Keys  

   
Shortcut Keys to Pull-down Menus  

All tab names on the Ribbon bar have an underlined letter.  You can select a tab by holding down the ALT 

key and pressing the underlined letter.  Once a tab is displayed, you can select a menu option by pressing 

the underlined letter in the option name.  

    
ALT + F File Tab    
ALT + E Edit Tab    
ALT + A Add Tab    
ALT + V View Tab    
ALT + R Report Tab    
   
Shortcut Keys for Main Views  
   

ALT + L Tools Tab    
ALT + C Search Tab    
ALT + I Internet Tab    
ALT + O Options Tab    
ALT + P Help Tab    

ALT + F1 Legacy Home Tab    
ALT + F2 Family Tab    
ALT + F3 Pedigree Tab    

ALT + F4 Descendant Tab    
ALT + F5 Chronology Tab    
ALT + F6 Index Tab    

   

Shortcut Keys to Bypass Menus on the Main Views  

Many menu options have shortcut keys listed next to them.  You can choose a menu command by 

holding down the CTRL key and pressing the other key.  The shortcut keys listed below are meant to 

be used only from the main views in Legacy (Legacy Home, Family, Pedigree, Descendant, 

Chronology, and Index).  On other forms, some of these shortcut keys have other functions.  

    

CTRL + A  Displays the Ages dialog box.  (On the Legacy Home tab, this shortcut key highlights the entire 

page contents.)  

CTRL + B  Backup a Family File  

CTRL + E  Export a GEDCOM File  

CTRL + N  Add a New, Unlinked Person.  (On the Legacy Home tab, this shortcut key opens the Home 

contents in a separate browser window.)  

CTRL + O  Open a Family File.  (Not available while on the Legacy Home tab.)  

CTRL + P  Opens the Picture Center.  (On the Legacy Home tab, this shortcut key opens the Print window 

for printing the Legacy Home page contents.)  

CTRL + Q  GEDCOM Import  

CTRL + S  Display Preferred Startup Family.  (Not available while on the Legacy Home  

tab.)  

CTRL + T  Advanced Tagging  

CTRL + W  Web Page Creation  

CTRL + Z  Opens the Customize window (ALT + Z also opens the window)  

   

Shortcut Keys in Dialog Boxes  

Most command buttons shown in dialog boxes have an underlined letter in their description.  You can 

click a button by holding down the ALT key and pressing the underlined letter.  This is equivalent to 

clicking on the button with the mouse cursor.  
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)   

)   

Other Shortcut Keys  

From the Information, Marriage, and Notes windows, you can press F4 to display the Sources window.  

From the Information and Marriage windows, you can press F5 to display the Notes window.  From any 

Note field, you can press F7 to start the spell checker.  From the Information, Marriage and LDS 

windows, F8 can be used to duplicate field contents from the previously saved record.  You can also 

press Ctrl-F9 to memorize any location field and F9 to play the memorized field back to any other 

location field.  (Shift-F10 / F10, Shift-F11 / F11 and Shift F12 / F12 also work the same way to 

memorize and play back field entries.)  

   

Shortcut Keys for the Source Clipboard  

There are shortcut keys available when assigning source citations from the Source Clipboard.  

   

Alt-1  Opens the source clipboard.  (Same as clicking  

 Alt-2  Assigns to the current field.  (Same as clicking  )  

Alt-3  Assigns to all non-blank fields.  (Same as clicking  

 Alt-4  Assigns to the Unspecified area.  (Same as clicking  )  

   

Shortcut Keys   

Family and Pedigree View  

The following single shortcut keys are available while working in the Family or Pedigree View.  To use 

the shortcuts, simple type the one-character command.  The commands are executed immediately 

when you press the letter.   

   

Single key commands:  

? Help (help on shortcut keys)    

F Find (displays Search window)    

G Go (to RIN #)    

I Index (displays Name List)    

M Marriage (displays Marriage List)    

X Exit (prompts for confirmation to exit Legacy)    

   

Shortcut Keys on Family View  

The following shortcut key combinations are available while working in the Family View.  To use the 

shortcuts, simple type the two-character command.  The commands are executed immediately after 

you press the second letter.  

Two-Key Commands  

AD Add Daughter    
AH Add Husband    
AS Add Son    
AW Add Wife    
C1-C9 and CA-CF     
Child 1 - Child 9 and Child 10 - Child 15    
  (moves the child to the Husb-Wife level)    
E1-E9 and EA-EF      
Edit Child 1 - Child 9 and Child 10 - Child 15    
EH Edit Husband    
EM Edit Marriage    

EW Edit Wife    
HP Husband's Parents    
LD Link Daughter    
LH Link Husband    
LS Link Son    
LW Link Wife    
ND New Daughter    
NH New Husband    
NS New Son    
NW New Wife    
WP Wife's Parents 
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Shortcut Keys on Other Forms 
The following shortcut keys are available while working in various forms in Legacy.  Not all of these are 
available on all forms. 
  
While in a Note-type field: 
Ctrl-B  Bolds the selected characters or words if some have been highlighted by dragging the mouse over 

them.  If nothing is currently selected, pressing Alt-B turns on bold mode so that successive text is 
bolded as you type it. 

Ctrl-I  Italicizes the selected characters or words if some have been highlighted by dragging the mouse 
over them.  If nothing is currently selected, pressing Alt-I turns on italicize mode so that successive 
text is italicized as you type it. 

Ctrl-U  Underlines the selected characters or words if some have been highlighted by dragging the mouse 
over them.  If nothing is currently selected, pressing Alt-U turns on underline mode so that successive 
text is underlined as you type it. 

Ctrl-S  Superscripts the selected characters or words if some have been highlighted by dragging the mouse 
over them.  If nothing is currently selected, pressing Alt-S turns on superscript mode so that 
successive text is superscripted as you type it. 

Ctrl-F  Opens the Find dialog box where you can search for text within the note. 
Ctrl-C  Copies highlighted text to the Windows clipboard. 
Ctrl-X  Cuts highlighted text from the notes field and places it on the Windows clipboard. 
Ctrl-V  Pastes any text currently on the Windows clipboard to the current position in the note field. 
Ctrl-Tab  Inserts a tab character into the note.  (Using tab characters to try to line up columns of information 

may not result in the desired format when printed on reports.) 
F3       Continues the search to find the next match after starting a search with Ctrl-F. 
Ctrl-Z  Undo.  Removes any text entered since the last time the note was changed.  (This is a Windows 

function.  If you are entering text, anytime you exit a field, or do some other function, like spell 
checking or searching, the undo feature is reset.) 

F6       Pops up the Character Map where you can select one or more special character to insert into the 
note.  This can be used to select copywrite symbols or other characters not shown on your keyboard. 

F7       Starts spell checking. 
Ctrl-P  Privatizes highlighted text by enclosing it in [[ and ]] characters. 
Ctrl-Space  Removes all formatting from the note including bolding, italicizing, underlining, and 

superscripting. 
Ctrl-R, Alt-R, F8 Pressing any of these keys works the same as clicking the Repeat button which repeats 

the field contents previously saved on the same type of form. 

 

Reprinted from Legacy 10 Help System. 10-1102:220202 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/character_map.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Legacy10/Legacy10.chm::/html/spell_checking.htm

